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PEPPER GUIDE 4: 

ENTER AND EDIT PEPSTORE VARIABLES AND PVSP DATA 

 

Overview 

For each PepFile entered and saved in PEPPER there is an associated database called 
PepStore that contains over 20,000 fields also called variables. These variables have 
both numbers (e.g., V0, V34, V3314) and names (e.g., FileName, SampType, PCC). 
Some values for variables are entered manually and can be edited as needed. Other 
variables, such as the data that appear in PepAnalyses outputs, are computed by 
PEPPER based on the PepFile's perceptual and/or acoustic data. The latter variables 
cannot be entered or edited manually and therefore will not be addressed in this guide. A 
"Copy Demographics" feature allows certain variables to be copied from one PepFile to 
one or more other PepFiles, which can save keyboarding time in situations where multiple 
PepFiles have the same demographic variables (i.e., sex, age, transcriber name, etc.). 

Data from the Prosody-Voice Screening Profile (PVSP) (Shriberg, Kwiatkowski, & 
Rasmussen, 1990) are also entered and stored as variables in PepStore. As mentioned 
elsewhere, the PVSP is completed for conversational samples only and is required for 
completing acoustic analyses on conversational samples. 

 

Getting Acquainted with the PepStore Database 

A PepFile must be open in PEPPER in order to view, enter, or edit variables in PepStore. 
After opening the PepFile, click on the PepFunctions menu in PEPPER, use the mouse 
to highlight the PepStore submenu, and then click on Enter/Edit/View PepStore. A new 
window will open that displays all of the open PepFile's corresponding variables in the 
PepStore database. The variables are arranged in numeric order in columns with 1000 
variables per column. The line for each variable contains the following from left to right: 

1. The variable number 
2. The value that has been entered or computed for that variable. The blue 

characters indicate variables that can be entered or edited; the black characters 
indicate values or data that are generated by PEPPER and cannot be changed by 
the keyboarder. An asterisk (*) indicates that the value is undefined. 

3. The variable name. If the variable has a name, it appears next. The variable name, 
which may be an abbreviation, is followed by a colon. Following the colon is a 
description of the variable. For some variables, there is information in parentheses 
that serves as a guide to the keyboarder as to how the value should be entered. 
For example, for V2, "Sex," a "1" is entered for "male" or "2" for "female" (not "M" 
or "F"). 

https://uwmadison.box.com/s/dw2pvjnd0cjxw989e5m4ew019z39elg2
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The horizontal and vertical scroll bars to the bottom and right of the screen, respectively, 
can be used to move around within PepStore. The up and down arrow keys on the 
keyboard can be used to move vertically line by line from one blue variable to another; 
"black" variables in between "blue" variables are skipped. The left mouse button can be 
used to click on any of the "blue" variables. To jump to a specific variable or section in 
PepStore, press Ctrl+G. A window opens wherein a section of the database can be 
selected from a drop-down list, or a variable name or number can be typed into a field. (If 
entering a variable number, it is not necessary to type the "V" preceding the number.) 
After choosing a section or entering a variable, click OK. PEPPER will jump to the first 
variable in the chosen section or to the variable specified by the keyboarder.  

 

Entering and Editing PepStore Variables 

The procedures for entering variables are the same for PepFiles and protocols. Any "blue" 
values can be entered or edited in the PepStore database window. Any variables that 
require specific coding or formatting conventions have descriptions or keys in 
parentheses; these should be followed so that PEPPER "recognizes" the data, which may 
be especially important for some analyses. 

To enter or edit variables in PepStore,  

1. Open PEPPER. 
2. Open the PepFile or protocol (PG3). 
3. Open the PepStore window by clicking on the PepFunctions menu, highlighting 

PepStore, and then clicking on Enter/Edit/View PepStore. (NOTE: The PepStore 
window will appear over and "hide" the PepFile transcript.) 

4. Enter a value into the corresponding "blue" field for each required variable and 
each additional variable of interest by clicking on the blue asterisk and entering 
number(s) and/or letter(s). Follow any applicable keyboarding guidelines 
described in parentheses in the variable line. Edit a previously entered "blue" value 
by left-clicking in the field and adding, deleting, and/or typing character(s) to be 
changed. 

5. Close the PepStore window by clicking on the red X button in the upper right 
corner. After closing PepStore, the PepFile/protocol window is again visible. 

6. Save additions and changes made in PepStore by going to the File menu and 
choosing “Save” or typing Ctrl+S. If you forget to save after exiting PepStore, you 
will be prompted to save your changes before exiting the PepFile and/or PEPPER. 

 

Required and Common PepStore Variables 

The fields for the following variables must have values (i.e., no asterisks) for 
PepAnalyses (PepClass and PepAssess - PG7) computations and outputs: 

https://phonology.waisman.wisc.edu/wp-content/uploads/sites/532/2019/07/PEPPER-Guide-3.pdf
https://phonology.waisman.wisc.edu/wp-content/uploads/sites/532/2019/07/Pepper-Guide-7.pdf
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 V0 "FileName" - This "black" value is automatically filled in by PEPPER. It is the 
file name under which the PepFile is saved. 

 V2 "Sex" - This "blue" value must be manually entered as 1 or 2 (1=male; 
2=female). 

 V4 "Months" - This "blue" value is the participant's age in months and must be 
manually entered. 

 V34 "SampType" - This "blue" value is the type of sample or speech task [1 = artic 
test (i.e., single word), 2 = continuous (i.e., conversational speech), 3 = multiword 
(i.e., phrases or sentences)] and must be manually entered. 

 V35 "SampMode" - This "blue" value is the speech sampling mode (1 = 
spontaneous, 2 = imitative, 3 = other) and must be manually entered. 

See Table 1 below for values that should be entered for variables 34 and 35 for speech 
tasks administered as part of the Madison Speech Assessment Protocol (MSAP). 

The following variables are commonly entered but optional. They are listed here because 
they may be of particular use or interest to other PEPPER users: 

 V26 "PepStore" - This "blue" record-keeping number is assigned to the PepFile 
transcript. Every PepFile entered has its own unique PepStore number. 

 V32 "ExamDate" - This "blue" value is the date that the speech sample was 
collected. It is particularly informative for samples collected on different dates for 
the same participant (i.e., multiple treatment sessions, testing dates for longitudinal 
studies). 

 V40 "TransWho" - This "blue" value is the name of the person who phonetically 
transcribed the sample. 

 V41 "SSegWho" - This "blue" value is the name of the person who completed the 
suprasegmental ratings (i.e., the person who coded the PVSP) and applies only to 
the conversational sample. 

 V42 "SSegUtts" - This "blue" value is the number of non-excluded PVSP 
utterances that were coded for prosody and voice. (Again, this applies only to the 
conversational sample.) A number less than 24 in this field may indicate that the 
sample is short and/or does not have sufficient data for some analyses. 

 V44 "Subject" - This "blue" record-keeping "subject number" is a unique number 
that is assigned to the participant/speaker. For all PepFiles for a given participant, 
the value entered for this database variable is the same. 

 V45 "RemotSubjID" - This "blue" record-keeping "remote subject identification 
number" is a number that has been assigned by an external, collaborative clinical 
or research site.  

 V14026 "Peplog" - This "blue" record-keeping "Peplog number" serves as a way 
to organize, file, and locate hard copies of recordings (tapes, disks, etc.) and/or 
folders containing hard copies of scoring forms, questionnaires, etc. A Peplog 
number can be assigned to more than one PepFile transcript and/or more than 
one participant. 

  

https://phonology.waisman.wisc.edu/about-the-msap/
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MSAP Task Variable 34 Variable 35 
Conversation (CS) 2 1 

CWT 1 2 
DDK 1 3 
EST 3 2 
GF 1 1 
LST 1 2 

MWT1 1 2 
MWT2 1 2 
NRT 1 2 
RST 1 2 
SCT 1 3 
SPT 3 2 
SRT 1 2 
SVT 1 3 
VT 1 1 2 
VT 2 1 2 
VT 3 3 2 

Table 1. Sample type (V34) and sample mode (V35) values for MSAP tasks. 

 

The "Copy Demographics" Feature 

This feature allows you to copy demographic variables from one PepFile to one or more 
other PepFiles. (NOTE: Non-demographic variables cannot be copied using this feature.) 
To copy demographic variables from one PepFile to another, follow these steps: 

1. Open PEPPER. 
2. Create or open a PEPPER variable list (*.pvl) (PG6) that includes the variables to 

be copied. Leave the list open. 
3. Open the PepFile that will be receiving the values. 
4. Click on the PepFunctions menu, highlight PepStore, and then click on Copy 

Demographics....A window will open wherein you can select the PepFile that is the 
source of the values to be copied. 

5. Select the PepFile that is the source of the values to be copied and click the Open 
button. This window closes. The selected source PepFile does not open, but the 
values specified in the open variable list are copied from its PepStore database 
into the database of the PepFile that is still open and now visible on the screen. 

6. Before closing the PepFile that has received the values, click "Save" under the File 
menu or type Ctrl+S. If you forget to save after exiting the PepStore database, you 
will be prompted to save your changes before exiting the PepFile and/or PEPPER. 

7. Close the *.pvl (or save the *.pvl before closing if it will be used in the future). 

 

https://phonology.waisman.wisc.edu/wp-content/uploads/sites/532/2019/08/PEPPER-Guide-6.pdf
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Entering PVSP Data 

This section assumes that the keyboarder is sufficiently familiar with PVSP procedures, 
terms (e.g., exclusion code, codable utterance, Sequential Utterance Log), and forms to 
understand and enter PVSP variables as described in this section. Training materials for 
the PVSP are available from our website. To open the window where PVSP data are 
entered in PEPPER, complete the following steps: 

1. Open PEPPER. 
2. Open the CS Pepfile (*.pep). 
3. Open the PVSP Log entry window by clicking on the PepFunctions menu, 

highlighting PepStore, and then clicking on Enter/Edit/View PVSP Log. (NOTE: 
The PVSP Log window will appear over and partially or completely "hide" the 
PepFile transcript.) 

All of the PVSP variables that can be entered are indicated by blue asterisks; when the 
PVSP Log window opens, the cursor is automatically placed at the first blue asterisk. 

The PVSP Log window is divided into 3 parts: 1) Identification (found on p. 1 of the PVSP 
Scoring Form) and supplemental information (if applicable, found on the PVSP Scoring 
Supplemental Sheet); 2) "Combination Codes," which are utterance-by-utterance 
prosody and voice codes from the Prosody-Voice Coding Log (on p. 3 of the PVSP 
Scoring Form), and 3) "Sequential Utterance Log," which are the codable utterance 
numbers and exclusion codes (if any) recorded in the Sequential Utterance Log found in 
the section at the top of p. 3 of the PVSP Scoring Form.  

Below is an example of the first section of the PVSP Log window wherein PVSP variables 
(blue text) have been entered. The PepStore variable numbers in the first column do not 
appear in the PVSP Log view in PEPPER. As mentioned previously, all values in the 
second column are blue asterisks until data are entered to replace them. Entered values 
are also in blue text and can be edited like any other "blue" variables in the PepStore 
database. The third column contains the label and description of the variable, plus any 
keyboarding guidelines in parentheses. 

 V14008  speaks softly PVSP General Comment 

 V14016  0  Narrative-- Re-tell as story (0=no 1=yes) 

 V14017  0  Narrative-- Make up a story (0=no 1=yes) 

 V14018  0  Narrative-- Comments on pictures (0=no 1=yes) 

 V14019  0  Narrative-- Comments on actions (0=no 1=yes) 

 V14015  0  Narrative-- Other (0=no 1=yes) 

 V14020  1  Conversation—Spontaneous interaction (0=no 1=yes) 

 V14021  0  Conversation—Controlled interaction (0=no 1=yes) 

https://phonology.waisman.wisc.edu/pvsp-manual/
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 V14022  0  Conversation—Interview (0=no 1=yes) 

 V14023  0  Conversation—Other (0=no 1=yes) 

 V14024  6/2/17  Scoring date 

 V14025  McSweeny Scorer 

 V14026  3581  Tape Label (i.e., Peplog Number) 

 V14027  *  Tape Side (hold-over from the days of audiocassette tapes, no  
     longer used) 

 V14028  0:48  Counter Number, beginning of sample 

 V14029  1:16  Counter Number, first coded utterance 

 V14030  8:10  Counter Number, last coded utterance 

 V14031  21  Coding time (in minutes) 

 V14032  40  Total time (in minutes, glossing time plus coding time) 

 V14033  0  DiffJudg: Difficult to judge 

 V14034  0  Telegraf: Telegraphic speech (0=no 1=yes) 

 V14035  0  RespInvl: Respiratory Involvement (0=no 1=yes) 

 V14074  18  Total Number of 4+ Utterances 

As mentioned previously, almost all of the values in the first section above come from 
information written in the "Identification" section on the first page of the PVSP Scoring 
Form and from the PVSP Scoring Supplemental Sheet. The last value (V14074) is the 
total count of check marks recorded in the “4(+) Words” column of the "Prosody-Voice 
Coding Log" on page 3 of the PVSP Scoring Form. The 4(+) words boxes are checked 
for the coded utterances that contain 4 or more intelligible whole words.  

The following values in the "Identification" section of the PVSP Scoring Form are not 
included/entered in the PVSP Log window. They can be entered using the regular 
PepStore database view described on p. 2. As mentioned previously, values are required 
for V2 and V4. 

 V1  Last, First Name 

 V4  154  Months 

 V2  1  Sex (1=male 2=female) 

 V32  6/16/17  ExamDate: Date of speech sample 

 V33  McSweeny ExamWho: Sampling examiner 

The “Screening Outcome” part of the "Identification" section on p. 1 of the PVSP Scoring 
Form is not entered in the database. 
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The "Combination Codes" section of the PVSP Log window is where all inappropriate 
codes and Notes recorded in the "Prosody-Voice Coding Log" on p. 3 of the PVSP 
Scoring Form are entered. A combination code is the concatenation, separated by 
spaces, of inappropriate codes for each coded utterance. Even though there are 25 rows 
on the form, note that there are lines to enter data for only 24 coded utterances in 
PEPPER. If fewer than 24 utterances have been coded, enter the data for those 
utterances that have been coded and leave asterisks in the fields for the remaining 
utterance numbers up to and including utterance 24.  

Only inappropriate codes (all codes other than '1') are entered; a code of '1' (the code for 
"appropriate") is never entered. Multiple inappropriate codes are separated by spaces. 
To enter a note, type a slash (/) followed by the note. Circled (i.e., unsure) codes are enter 
either by preceding them with a period (.) or by surrounding the code with parentheses. 
There is a limit to the number of characters that can be entered in each line. It may be 
necessary to abbreviate comments in the Notes column in order to avoid exceeding the 
character limit, especially if multiple inappropriate codes are entered. 

Below is an example of a "Combination Codes" section with entered data for 22 coded 
utterances. The database variable numbers in the first column do not appear on the PVSP 
Log entry screen. Additional entry guidelines follow this example. 

 V14153  1  

 V14154  2 .24  /thought PRO, rough at end 

 V14155  3 19 

 V14156  4   /thought PRO 

 V14157  5 .17 .24 

 V14158  6 .17 

 V14159  7 6 17 .24 

 V14160  8  

 V14161  9 17 24 30 

 V14162  10 .15  /small BLO  

 V14163  11   /rough, breathy at end 

 V14164  12 17 

 V14165  13 

 V14166  14 6 24 
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 V14167  15 .17 

 V14168  16 .14 24  /borderline GF, monotone 

 V14169  17 29  /24 & 26, shift 

 V14170  18 

 V14171  19 

 V14172  20 .17 24  /thought PRO 

 V14173  21 24 

 V14174  22 2 .17 

 V14175  23 * 

 V14176  24 * 

  

All blue values start out as *, which indicates missing data. If an utterance is coded as 
entirely appropriate and has no Notes to enter (as in utterances 1, 8, 13, 18, and 19 in 
the example above), the asterisk is deleted. If there are fewer than 24 codable utterances 
(i.e., utterances with combination codes), the remaining blue values should remain as 
asterisks (as in the fields for utterances 23 and 24 above). 

Inappropriate Stress codes 15 and 16 require additional comments (which should be 
recorded in the Notes column of the PVSP Scoring Form). When inappropriate code 16 
(Multiple Stress Features) is entered, PEPPER brings up a dialog to select two or three 
Stress codes from 13, 14 and 15. When an inappropriate Stress code 15 or an 
inappropriate Stress code 16 that includes a code 15 is entered, PEPPER brings up a 
dialog to select one or more of the following abbreviations: MP, BLO, PRO, EE, and SING. 
The selected abbreviations will automatically be added to the Notes column. Additional 
data can be entered to the Notes column if space allows. (If a 15 or 16 code is recorded 
in the Prosody-Voice Coding Log without the required supplemental abbreviation(s) in the 
Notes section, it should be returned to the scorer with a request to add this information to 
the form.) 

Certain codes are incompatible with each other; attempts to enter both incompatible 
codes in the same utterance line will generate an error message. PEPPER will generate 
an error message if the keyboarder attempts to enter any of the following incompatible 
code combinations: 

 Inappropriate Rate code 12 (Fast/Acceleration) and an inappropriate Stress code. 
In an utterance with fast/accelerated rate, stress cannot be judged. In this situation, 
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an asterisk should be recorded in the Stress Approp column in the "Prosody-Voice 
Coding Log" on p. 3 of the PVSP Scoring Form.  

 Inappropriate Pitch code 19 (Low Pitch/Glottal Fry) or 21 (High Pitch/Falsetto) and 
an inappropriate Laryngeal Quality code. In an utterance with glottal fry or falsetto 
pitch, laryngeal quality cannot be judged. In this situation, an asterisk should be 
recorded in the Quality Approp column in the "Prosody-Voice Coding Log." (Note: 
Resonance can still be judged, and an inappropriate Resonance code can be 
recorded and entered.) 

 Inappropriate Laryngeal Quality code 23 (Breathy) and an inappropriate Pitch 
code. In an utterance with breathy laryngeal quality, pitch cannot be judged; an 
asterisk should be recorded in the Pitch Approp column in the "Prosody-Voice 
Coding Log." 

For more detailed information on, including the rationale for, these incompatible code 
combinations, see the PVSP manual. 

The last section of the PVSP Log entry window contains the values (coded utterance 
numbers and exclusion codes) taken from the "Sequential Utterance Log" found on p. 3 
of the PVSP Scoring Form. (NOTE: The first 3 codable utterances--called U1, U2, and 
U3--are recorded and entered in the "Sequential Utterance Log" but are not judged for 
prosody and voice; i.e., they do not have combination codes.) This section, unlike the 
previous 2 sections, does not have corresponding PepStore database variable numbers; 
however, the exclusion code counts in the PepStore database for V14038 through 
V14072 are calculated from the data entered in this section. 

Ideally, the utterance numbers in the "Sequential Utterance Log" should correspond to 
the utterance numbers in the handwritten transcript and corresponding PepFile. To 
streamline the entry process, default values are shown as the "Sequential Utterance Log" 
values are entered in PepStore. These default values include the next utterance number 
for a codable utterance (starting with U1, U2, U3 for the first three codable non-coded 
utterances) and the previously entered exclusion code, if any. To select/enter the default 
codable utterance number, press the Enter key. To select/enter the default exclusion 
code, press the 'x' key. To enter something else, type it. If more than one exclusion code 
must be entered for an utterance, enter a space between each one. 

Here is an example of data entry for the "Sequential Utterance Log:" 

1 U1 

2 U2 

3 C5 C7 C12 

4 U3 

5 C7 
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6 1 

7 2 

8 C2 

9 3 

10 4 

11 C2 C5 

12 C5 

13 5 

14 6 

15 7 

16 8 

17 9 

18 10 

19 11 

20 12 

21 13 

22 14 

23 15 

24 16 

25 17 

26 18 

27 19 

28 20 

29 C5 C7 

30 21 

31 22 

32 23 
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33 C7 

34 24 

When entering the data from the "Prosody-Voice Coding Log" or the "Sequential 
Utterance Log," the commands on the Edit menu to Cut, Copy, Paste, Insert or Delete a 
line can be used as needed. 

 

PVSP Data Entry Error Messages 

* line in middle of combination codes: The * lines should occur in the combination 
codes section only when there are fewer than 24 coded utterances. In that case, they 
should be used for the utterances in the combination codes section past the number of 
utterances coded. In this situation, PEPPER identifies and flags a line with a blue asterisk 
( * ) followed by a line with one or more entered combination codes. This most commonly 
happens when the keyboarder forgets to delete the * for a coded utterance with no 
inappropriate codes or notes.  

Sequential Utterance Log Missing: This error message appears when the combination 
codes are entered without entering data in the corresponding "Sequential Utterance Log." 

There are nn coded utterances in Seq. Utt. Log, but there are mm Combination 
Codes: The number of coded utterances entered in the "Sequential Utterance Log" 
(ignoring U1, U2, U3) must equal the number of utterances with entered combination 
codes. This error message appears when they do not. 

Seq. Utt. Log has an empty line: There should be a code on every "Sequential Utterance 
Log" line. The “Delete Line” feature on the Edit menu can be used to remove the empty 
line. 

Value must be at least nn; Value must be no more than mm: The value entered is too 
small or too large. For example, the value for “Conversation--Spontaneous interaction” 
must be 0 or 1. A negative value is too small; a value of 2 or more is too large. 
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